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Introduction

Thank you for reading this manual!

Thank you for downloading the HD24tools software. This software was
designed to help users of the Alesis ADAT HD24 recorder perform daily
tasks that were previously difficult or impossible to achieve.

The support of the HD24 community has been of great help in developing
this software. As we are actively seeking to continuously improve this
software, you are encouraged to contact the author about any feature
requests, bug reports or ideas for improvements you may have.

As the stream of response to the software has been increasing at a steady
rate, the author has put together these pages to help everyone get the
information they need. By reading this manual before asking questions,
you help the author earn time to crack the really tough ones! Should you
have read this reference and still have questions, feel free to emalil the
author, so that this manual may be improved.

Hopefully the software and this manual help you get the most out of your
Alesis HD24 recorder.

Sincerely,

Marc Brevoort

Disclaimer: The author is not affiliated with or supported by Alesis.



About the HD24tools software

The HD24tools software was originally developed to fulfill the need of
transferring audio data from FST disks to Linux-based workstations. After
fulfilling this need, the software has been extended with some additional
features, and ported over to various other operating systems, platforms and
architectures. As a result, the HD24tools software will allow you to transfer
your audio over almost any connection to almost any computer running
almost any operating system.



Key features of the HD24tools software

The

HD24tools software consists of two main programs; one is

HD24connect, the other is HD24hexview. Normal users will probably
mostly use HD24connect, which is the program that allows transferring
audio from HD24 ADAT FST disks. Key features of HD24connect are:

Allows transferring audio to computers whether they run Linux,
Windows or MacOS

Allows using the original Alesis FirePort 1394, as well as low-cost
alternatives such as external USB brackets or USB smart cables

Automatic splitting up large files into smaller, custom-sized pieces
during transfer

In the case of disaster, allows safe, read-only data recovery, allowing
Do-It-Yourself data recovery without requiring any knowledge of the
FST file system

Permits audio transfers between locate points

Advanced transport control allows fast audio previews directly from
FST disk

Direct streaming audio to other audio applications (Currently for
Linux only)

Writing disk contents to file or printer
Batch transfer of multiple songs from HD24 drive to PC
Export to mono, stereo or multi-track files

Import from mono, stereo or multi-track files up to the length of
existing songs

Advanced recovery features allowing 100% safe, read-only recovery



The other program, HD24hexview, is a hex editor. It has the following
features:

e Directly displaying the on-disk data, permitting fast navigation of
large disks with minimal memory requirements

e Block selection

e Write block to file

e Checksum calculation

e Sector access relative to end-of-disk

e Read-only mode (default) and expert mode to help prevent accidents

e Doubles as a hex editor for binary files

Finally, some features are part of the core engine and shared by both
programs:

e Automatic detection of HD24 ADAT FST disks
e Allowing to force using non-FST or corrupt disks
e Permitting the use of image files and alternate headers

e Permits using any method of hooking up your drives to the computer

Additionally, the software supports most features that you have come to
expect from the official software: Multi-disk support, free space preview,
support for both FST version 1.00 and 1.10, 99 projects, 99 songs,
exporting to various file formats, and so on.



What's new in this last version?

New features in 0.9:

New tabbed GUI

Write support (finally!) allowing writing audio to existing songs; either
mono, stereo or multi-track

Exporting drive images

Recorder tab with meters that faithfully simulate HD24 meter levels
during playback, three peak hold modes, slider seek, proper
solo/mute buttons and transport controls which should be familiar to
most HD24 users

Added punch in/punch out locate points

Changed default time display to 30 frames per second instead of
1/100 second for better future MIDI compatibility with HD24

Larger transport control buttons

Signal detection on transfer tab



Before using the software

Important: The software is provided free of charge in the hope that it will
be useful, but is provided AS IS with ABSOLUTELY NO WARRANTY,
expressed or implied. The author can not be held liable for any damage
that may arise directly or indirectly from the software. Use the software at
your own risk.

HD24connect version 0.9.0 is the first version with write support. As such,
although the software has been tested extensively, write support should be
considered EXPERIMENTAL. It is strongly recommended make backups
before using write support, either using the functionality provided by
HD24tools or using the HD24 recorder.

Please also take in account the regular disclaimers that apply for the
operational conditions for your hardware- That is, do not attempt to hot-
swap a drive that is not hot-swappable, do not use in overly moist
conditions, switch off devices before hooking them up, and so on. Consult
your hardware manuals to inform yourself about further limitations.

A considerable amount of time was spent to develop the software. If you
use and like the software and wish to support it, please consider making a
donation to the author. Spread the news. Please do not host the software
on other sites- you can always download the latest version from the
following page:

http://ringbreak.dnd.utwente.nl/~mrjb/hd24tools/download.html



Choosing your hardware

As HD24tools software works with a variety of hardware, you may want to
take a moment to pick the hardware that suits you best.

e The Alesis Fireport will work on any computer with a firewire
interface, and allows hot-pluggable operation. It will also allow you to
use features specific to Alesis' FST/Connect.

e If you do not want to get any additional hardware before performing a
test drive of the HD24tools software, you can test with a drive image
or connect your FST drive directly to the IDE interface of your
computer. The drive will need to be jumpered as to MASTER. DO NOT
DO THIS if you are uncomfortable swapping around drives.

e If you do not mind swapping drives from HD24 caddies to an external
USB bracket, almost any external USB case will do.

e The original Alesis HD24 drive caddies were designed by a company
called ViPowER, Inc. You may wish to consider using one of the
compatible products that they have manufactured. Depending on
your needs, you could use either of the following (and possibly
others):

e ViPowER SuperRack model VP-10KFU-133

This is an internally mountable drive bay which connects
directly to your IDE interface. Fast but NOT hot-swappable.
Requires the ADAT drive to be the only drive on the interface.

e ViPowER SwapRack VP-1028LSF

An internally mountable drive bay which connects to an
external USB interface. Hot-swappable. Requires an available
USB port.

e Others

Compatibility of HD24tools with other ViPowER hardware is
likely but unconfirmed.

Alesis' FST/Connect only supports FireWire drives. It will not work with
aforementioned USB drive bays.



System recommendations

The HD24tools software should be able to run on almost any system with
almost any specification. Most likely, it will work on yours. To find out if it
does, give it a try. Should you find that it doesn't, please contact the author
so that we can consider making HD24tools work on your system as well.

Requirements for running the software:

- Sulfficient drive space to hold the software and audio files to be
transferred

- Windows 2000, Windows XP, MacOS X 10.3, 10.4 (powerPC) or Ubuntu
Linux (other distributions may work as well)

- Sound card (for audio previews)



Precautions

When connecting or disconnecting an HD24 ADAT FST drive, always take
into consideration the precautions that apply for your hardware (switching
off devices before swapping drives, etc).

Until someone releases an official FST driver (which is not likely to happen
any time soon), your operating system will not support HD24 ADAT FST
disks. This means that your operating system will recognize that there is a
disk connected to your machine, but it will not understand its contents.

Because of this, ADAT disks are usually incorrectly recognized as
unformatted, and the operating system will possibly offer to initialize or
format it for you. Under Windows this may look as follows:

Initialize and Convert Disk Wizard x|

Welcome to the Initialize and
Convert Disk Wizard

Thiz wizard helpz you to intialize new dizks and to corvvert
emphy basic disks to dynamic disks.

Y'ou can uze dvnamic dizks to create software-bazed RalD
wolumes that can be mirrored, or they can be striped or
gpanned acrozs muliple disks. You can also expand
zingle-dizk. and zpanned valumes withaut hawvipg o restart
the computer. T«%

After you corvert a dizk to denamic, vou can anly uge
Windows 2000 and later versions of Windows on any
volurne of that disk.

Tao continue, click Mest,

¢ Back

You should Cancel such dialogs and steer clear from such initialization
actions. If you initialize the disk, it will no longer be readable by the HD24
recorder. Should you be reading this after it is already too late, steps to
recover from this disaster are provided in the recovery section of this
manual.



Installing HD24tools (Windows)

The recommended way of installing HD24tools on Windows is by using the
graphical installer. The .zip file that you downloaded contains a file called
setup.exe, which, when run, will install the full version of HD24tools, all
required libraries, documentation and rescue headers.

When setup is started, it will display a screen similar to the following:

HD249tools 0.9 0PRE-beta - Setup Wizard

Welcome to the setup wizard for
HD24tools version 0.9.0PRE-beta

This Setup Wizard will install HD2 4tools version 0.9.0PRE-beta
On your computer.

Attention: You may need to run this wizard as administrator/
superuser/root.

Before continuing, please close all running proegrams.

WARNING: This program is protected by copyright law.

Click Next to continue; you will now be taken to the license agreement.



HD249tools 0.9 0PRE-beta - Setup Wizard

Please read the following license agreement carefully.

HDZ24tools End User License Agreement

This program is SHAREWARE. You are hereby granted
permission to download and use this software free of
charge, as well as to give away UMALTERED copies of it.

This program is provided in the hope that it
will be useful, but comes with ABSOLUTELY NO WARRANTY.

If you find this program useful, please make a donation
to the author. For details, see
http:/fringbreak.dnd.utwente.nl/~mrib/hd24tools/

This software is not endorsed not affiliated by Alesis.

@ | accept the terms in the license agreement
1 do not accept the terms in the license agreement

= Back Next =

Cancel

The license agreement is pretty liberal: you are allowed to use the program
free of charge and spread unaltered copies of it. You are encouraged to
donate to the development of HD24tools if you find the program useful. To
continue, accept the terms in the license agreement and click Next.

You will now be asked where to install the program files:

HD249tools 0.9 0PRE-beta - Setup Wizard

Setup will install HD2 4tools in the following folder. To
install in a different folder, click Browse and select
another folder.

After that, click Next to start the installation.

|c:\HD24tools\

Browse... |

= Back Next =

Cancel




The suggested installation directory will be fine for most practical purposes.
Unless you have specific wishes about the folder where you want
HD24tools to be installed, the default should be fine. You may want to
write down the installation folder at this moment for future reference- you
will need to know where the program is installed to run it.

After clicking Next, the files will be copied to the given location. Note:
HD24tools is quite light, so copying the files will take a very small amount
of time, sometimes under a second. This is normal.

HD249tools 0.9, 0PRE-beta - Setup Wizard
Installation Complete

HD24tools installation has been completed successfully.
You may now run it from the installation path.

Please click Close to terminate the installer.

Close

After installation is complete, open an explorer window and write the
installation directory in the address bar (typically C:\HD24tools). After
going to that folder, you can start HD24connect by double-clicking it.



Installing HD24tools (Linux)

Under Linux, installation should be similar to the installation on Windows.
You can extract the setup file from the downloaded .tar.gz or .tgz archive
and then run it. By default, installation will be done in the ~/HD24tools/
directory.

It should be noted that due to the relatively small number of Linux users,
the Linux installer has not undergone a lot of testing. If things do not
install smoothly, please contact the author so that we can work out the
final issues in the installer. The most likely cause for things not running is
that HD24tools cannot find the portaudio and 1libsndfile libraries.

On Linux, drive detection may fail if the user does not have direct
read/write access to the drive. This can normally be solved by running as
root (not reommended) or by altering your /etc/fstab file to allow direct
read access to common users. For instance, if your FST drive is usually on
/dev/hdc then your fstab entry may look as follows:

/dev/hdc none auto devmode=0775 0 0

Installing HD24tools (Mac)

On Mac, no installation is needed; simply download and open the proper
.dmg image and run directly from there. Should you wish to install, some
people have reported success copying over the files from the .dmg image
directly to their drive.



Normal operation

This chapter deals with normal operation of HD24connect. This means that
in these chapters, it is assumed that you start up HD24connect with a

normal, valid HD24 ADAT FST drive already connected to your system.

The main screen of HD24connect

The following is an example of what the main screen of HD24connect may
look like just after starting up, when a valid drive was found. The image
may differ slightly depending on the platform and operating system that

you are running.

| HDZ4 Connect 4
File Help
Drivﬁ| Project/Song | Rmrdnr| Copy to PC | Copy to HD24|
Drive information
Drive name: | 1: Drive Name hd

Number of projects: |4 FS version: |1_1D

Drive contents

Free space preview: [3 hr 02 min 24 sec | at [44100 | Hz. [24

Rename... |

| tracks

Catalog timestamp : Wed 2007-16-63 21:29:33 CEST
Volume name : Drive Name
Number of projects -

Project 1: Slander

1: Used BE:85:48.87, lGch. 44180 Hz
2: Betrayal Be:83:03.80, l6ch. 44100 Hz
3: Despair BE:84:13.51, 1l6ch. 44186 Hz
4: Winter Be:05:14.72, lech. 44188 Hz
5: Evermore Be:e5:81.44, 1lech. 44188 Hz
6: Unfaithfl BE:85:12.78, 16ch. 44186 Hz
7: Samples BB:85:37.95, &Bch. 88200 Hz
g8: SongZName ge:e0:34.84, 2ch. 44188 Hz
9: SonglOame Ge:e0:00.008, l6ch. 441808 Hz
18: Songllame gp:e0:00.00, l2ch. 38200 Hz
11: SonglZame GR:00:008.680, 12ch. 9%96BEE Hz
12: Song Name ge:ep:00.008, 6Gch. 38200 Hz
13: Song Name ge:eR:00.08, 2Zch. 44180 Hz
14: Song MName BR:00:008.080, 24ch. 44188 Hz

Project 2: Ogni~M ld~~ = - o o o

1l: Song Mame gp:ep:00.008, Bch. 44100 Hz
2: TjolkOckr~~~~}}{~}}{00:06:15.8%, 1l6ch. 44186 Hz

e i
3: ClustSize pe:eg:02.21, 2Z2ch. 44188 Hz

Project 3: ProjDanny

| »




Drive info

The Drive Info tab contains information about the currently selected drive,
as well as a directory listing of the contents of the currently selected drive
or drive image.

D249 Co p . 4
File Help
Dri'.m| Project/Song | Recorder | Copy to PC | Copy to HD24
Drive information
Drive name: | 1: Drive Name hd
Number of projects: |4 FS version: |1.1[} Rename... |
Free space preview: [3 hr 02 min 24 sec | at [44100 | Hz. [24 | tracks
Drive contents
Catalog timestamp : Wed 2007-16-63 21:29:33 CEST -
Volume name : Drive Name —
Number of projects -
Project 1: Slander
1: Used BE:85:48.87, lGch. 44180 Hz
2: Betrayal Be:83:03.80, l6ch. 44100 Hz
3: Despair BE:84:13.51, 1l6ch. 44186 Hz
4: Winter Be:05:14.72, lech. 44188 Hz
5: Evermore Be:e5:81.44, 1lech. 44188 Hz
6: Unfaithfl BE:85:12.78, 16ch. 44186 Hz
7: Samples BB:85:37.95, &Bch. 88200 Hz
g8: SongZName ge:e0:34.84, 2ch. 44188 Hz
9: SonglOame Ge:e0:00.008, l6ch. 441808 Hz
18: Songllame gp:e0:00.00, l2ch. 38200 Hz
11: SonglZame GR:00:008.680, 12ch. 9%96BEE Hz
12: Song Name ge:ep:00.008, 6Gch. 38200 Hz
13: Song Name ge:eR:00.08, 2Zch. 44180 Hz
14: Song MName BR:00:008.080, 24ch. 44188 Hz
Project 2: Ogni~M ld~~ = - o o R el
1l: Song Mame gp:ep:00.008, Bch. 44100 Hz
2: TjolkQckr~~~~}}{~}}1{00:06:15.89, 1l6ch. 441886 Hz
3: ClustSize pe:ee:02.21, 2ch. 44188 Hz
Project 3: ProjDanny =

If you have multiple drives connected to your system at the same time, the
Drive name dropdown box will allow you to switch between the detected
drives. The Rename button will allow you to rename the drive (in-memory
only, for now). The screen shows the number of projects on disk, along with
the file system version that the drive was formatted with.



The Free space preview shows an estimate of the available recording
time, based on a given sample rate and number of tracks that you can
select with the dropdown menus next to it. By changing the number of
tracks and sample rate, the preview will be automatically adjusted to
match.

To increase efficiency for people that work with many different drives,
HD24connect displays the drive catalog on screen. If desired, this catalog
can be exported to file or to printer with the following two menu choices:

e File -> Export catalog...

This choice allows us to write the catalog of the current disk to file,
permitting you to preview the contents of the catalog or to add layout
in your favorite word processor.

e File -> Print catalog...

This choice will send the catalog directly to the default printer.



Project/Song tab

The next tab is Project/Song.

- HDZ24 Connect -
File Help

Drive | Project/Song | Recorder | Copy to PC | Copy to HD24 |

Project information

Project name: | 1: Slander hd

Number of songs: |14 Rename... |

Song information
Song name: | 4: Winter hd

Number ﬂftrack5:|16 [ Write protected Rename... |
Duration: |DD:DS:14.?2 Sample rate: |441EID Bit depth: |24

Locate points: [START: 00:00:00.00 ~] Edit.. | Go |

Ready.

The Project information area shows a dropdown box which allows you
to choose the project that you want to look at, along with the total number
of songs in the project.

Project info

Project name: |1: Slander hd

Mumber of songs: |11 Rename... |

By default, the last project accessed on the HD24 recorder will be
displayed. The Number of songs field displays the total number of songs
that are recorded within the currently selected project. The Rename. ..
button is similar to the Rename. .. button on the Drive Info tab.



Below the Project info, you will find the Song Info. This area contains
various controls that are related to individual songs. By default, it will
display the last song accessed by the HD24 recorder. The information
displayed includes the number of tracks, song duration, sample rate, bit
depth (usually 24 bit) and write-protect status. Again, there is an (in-
memory) Rename. . . button.

Song info
Song name: [13: Song Name hd
Mumber of tracks: lzi [ Write protected Rename...
Duratior: [00:00:00.00 | Sample rate: [44100 | Bit depth:[24
Locate points: [START: 00:00:00.00 ~] Edit. | Go|

HD24connect displays durations and time codes in the format
HOURS:MINUTES:SECONDS.FRAMES. This matches the behaviour of the
HD24 recorder.

A special, unnumbered song entry named --All songs-- is available in
the song name dropdown box. When selected, this selects all tracks of all
songs of the entire project for batch transfers from HD24 drives to
computer. The export range for the song will be fixed, meaning that only
entire songs will be exported.

In addition to these settings, the Song info area shows the list of locate
points that are defined for the song. The usual 25 locate points that are
defined by the HD24 recorder are listed, as well as a virtual locate point
END which is located just after the last sample of the song.

Locate points can be set in-memory, and although they are never written to
disk, it is actually useful to be able to do this, because HD24connect allows
us to transfer audio based on these locate points.



The Edit... button next to the locate point list allows us to edit the locate
point that is currently being selected. When this button is clicked, a dialog
will popup.

dit locate point m

Location Name: [LocNam01

Hr Min Sec Secfl00
New locate point: 4 0 M T M2 ¥ 3

¥/ Set as start of export range (9]4 | Cance|

This dialog will permit us to change the name of the locate point, but more
importantly also the time code before which the locate point is situated.
The button above the subseconds allows us to switch back and forth
between hundreths of seconds, frames (30" seconds) and samples, which
permits us sample accurate wave export”, should we wish to do so.

The checkbox, which is only displayed for locatepoint 1 and 2, is enabled
by default. When editing locatepoint 1 and 2, this will cause these
locatepoints to automatically be used as start and end of the export range,
respectively.

It should be noted that the locate points should be seen as being located
between the samples; a locate point that has a value of 1 (sample) is
located just before sample 1 and just after sample 0. This notion is
important when we want to export data split up in several blocks without
overlapping samples: we should not do anything such as incrementing
sample offsets to allow this.

Just like on the HD24 recorder, locate point O (which is called START by
default) doesn't indicate a position within the song but the offset of the
song itself. During song exports, HD24connect will ignore the actual value
of this locate point and always consider it to be just before the start of the
song. Because of this, you may change the value of this locate point, but
this will have no effect whatsoever.

A In high-samplerate modes (88.2 and 96 kHz), locate points only occur every two samples and as such true sample
accuracy can not be obtained.



The Go button (next to the Edit... button) will move the transport
cusor/tape head to the currently selected locate point. In combination with
manually setting locate points, this allows us sample-precise jumps to
anywhere within the song. It should be noted that it is not possible to jump
beyond the end of the song. For the Go button to work, the transport must

have been previously activated by clicking the stop button on the recorder
tab.



The Recorder

Before exporting audio, you may wish to audition it. The Recorder tab
facilitates this by offering a convenient, familiar interface.
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The top of the screen shows a 24-track LED display, similar to the display
of the HD24 recorder itself. When auditioning a drive with HD24connect, it
will faithfully simulate what the HD24 recorder would have displayed.

There are three rows of buttons under the display. The first row of buttons
record-enables tracks. The record-enable buttons are present in the user
interface in preparation for realtime recording functionality. Clicking the
dot on the left of this button row allows you to record-enable all tracks at
once. As realtime recording functionality is not yet implemented, the
Recorder tab is locked to Rehearse mode.



The second and third button rows contain Solo and Mute buttons. This
allows you to single out tracks while auditioning the song.

Under the three button rows, we find the location slider. This slider shows
how far audio playback has progressed, and allows us to quickly jump to
any point in the song by dragging its handle with the mouse.

The bottom left shows an information display. This display shows the
current playback location and status messages. Beneath the display, there
are four buttons, and there is a drop-down on the right.

e The Peak mode button allows us to choose between No peak
hold, Temporary peak hold and Continuous peak hold.
These are similar to the peak modes of the Alesis HD24
recorder.

e The Peak clear button complements Continuous peak hold
mode by allowing us to reset the signal peaks manually.

e The A11 input and Auto input buttons are included for the
realtime recording feature which will be implemented in a future
release. Under Linux, The A2Al1l1 input button permits
monitoring signal levels coming from your sound card.

e The Stereo input mapping dropdown is included for the
realtime recording feature which will be implemented in a future
release. It is currently disabled. It will give control over how
stereo audio signals are routed from your audio hardware card
to HD24 tracks.

The transport controls are arranged in a layout similar to the Little Remote
Control that came with your HD24 recorder. The Rehearse button is
locked. It is included for the realtime recording feature which will be
implemented in a future release.

e During audio playback, it is possible to set four locate points by
clicking SET LocC followed by one of the buttons in the darkened area
(Loop start, Loop end, Punch in or Punch out).

e Clicking AUTO LOOP toggles loop mode. When loop mode is enabled,
playback will end at the Loop End locate point (Locate point 2) and
resume at the Loop Start locate point (Locate point 1). This is mostly
useful when streaming audio directly from disk.

e Clicking LOC 0 rewinds the transport to the beginning of the song.



e The LOOP START button resets the song cursor to Locate point 1 (or
sets Locate point 1 after SET LOC is pressed)

e The LOOP END button sets the song cursor to Locate point 2 (or sets
Locate point 2 when SET LoOC is pressed). Most useful when transport
is stopped.

e The PUNCH IN and PUNCH OUT buttons supply two extra locate points
that can be set on the Recorder tab, but currently have no additional
functionality.

e The Rewind button moves the song cursor backwards by 5 seconds,
if possible.

e The FFWD button moves the song cursor forwards by 5 seconds, if
possible.

e The STOP button stops audio playback. In addition, this will initialize
transport control and re-detect what audio playback mechanism is
available. Under Linux, this is useful to switch between Portaudio
and Jack without restarting the application.

During audio preview, the track selection checkboxes on the Copy to PC
tab will light up for tracks that have signal. It is possible to switch between
songs during audio preview. However, any locate points set in-memory
before the switch will be lost.



Copying audio from HD24 drives

The Copy to PC tab permits you to select a directory for file export, as
well as marking which tracks should be exported. By default, all tracks are
marked for export. If the song has less than 24 tracks, only the amount of
tracks allocated for the song is displayed.
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The Invert button will toggle all tracks between selected and unselected.
This is useful for quickly switching between exporting all tracks and
exporting no (or just a few) tracks.

Clicking the Range... button pops up a dialog which will let us choose
which range to export.



From location: |V R

To location: [END: +00:00:07.18 ]|

We select this range by choosing two locate points. Regardless of its value,
locate point START is always located before the beginning of the song,
whereas virtual locate point END is always located after the end of the
song. This means that selecting START and END will always export the
entire song.

Before performing an export, we may still choose in what format we wish to
export by selecting the desired format in the Format dropdown box.
Currently supported are 24-bit WAV files and 24-bit AIFF files. Although
these formats should be readable by most systems, some software
programs have trouble reading 24-bit PCM. In that case, the exported data
will mostly sound like loud noise. This can be resolved by finding a CODEC
that supports 24 bit PCM, or by loading the audio into a program that is
24-bit capable.

In addition to mono export, HD24connect permits exporting the audio as
stereo pairs and as multi-track audio. When exporting to stereo, you need
to select an even number of tracks. Exporting as multi-track audio will
export all audio tracks in the same file. Note that proper multi-track WAV
and AIFF support is rare and may not work with your favorite audio
program.

Finally, to transfer a sound, we can click the Transfer button which will
start a transfer of

e the selected tracks
e to the selected project directory
e from the indicated starting point to the indicated endpoint

e in the given sample rate and format.



WAV files can contain at most around 2 billion samples, which usually is
equivalent to around four and a half hours of music. If we try to create a
longer WAV file, the resulting file is not be a valid WAV file, and will
probably not play well in other audio programs.

To work around this limitation, under heading Transfer options
HD24connect permits splitting up exported audio into chunks of a given
maximum size. This will not only overcome the limitations of the WAV file
format, but it will also permit us to split up our audio into chunks that are
of a convenient size to store on other media, such as DVD.

The heading Transfer options also permits us to export files stamped
with a different sample rate than the rate at which they were originally
recorded. This is mostly useful for people that own the Alesis BRC and that
synchronize their HD24 to it. This may cause the HD24 to think that it is
recording at 48 kHz when in reality it is recorded at 44.1 kHz. As a result,
exported files will play back too fast. By stamping them with a sample rate
of 44.1 kHz, this problem is resolved. The audio is not resampled by
stamping export files with a different rate.



Copying audio to HD24 drives

The Copy to HD24 tab offers functionality to copy audio from file to an
existing song on the the HD24 drive.
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The screen shows 24 track slots which correspond to the 24 tracks of the
HD24 recorder. Using the Load... button, you can select which files you
want to transfer to the HD24 recorder. At first, do not worry about the
order in which you add the files to the track slots. You will be able to
correct this later. The file dialog that pops up after clicking the Load...
button will allow you to select multiple files. Selected files will be assigned
to the first empty track slot.

When you select a file that contains more than one track (for instance
stereo files), it will not fit on a mono track. You will be asked what you
want to do. You can either assign it to several track slots (one slot for each
channel that the file contains) or assign it to a single track slot.



By default, if you split a multi-channel file into multiple tracks, the channel
action selection to the right of the track slot will assign each respective
channel to a track slot, whereas by default a multi-channel file will be
mixed down to mono when it is assigned only to a single track slot. If you
wish to deviate from this default behaviour, simply select the desired
behaviour in the track action drop-down next to the track slot.

To move around files, click the track slots holding the files you want to
move to another HD24 track. This will highlight the track slot. You can
then move the file by clicking the up and down buttons on the right of the
track list.

If you wish to overwrite a track with silence, you do not need to select a file.
Simply choose Erase as track action in the drop down right to the track
slot.

When a track slot is empty, that track will be preserved on the HD24 drive,
unless you selected Erase as track action.

To clear a track slot and preserve the track, you can select the track slot by
clicking it, and then clicking the Clear button.

After all is set up for the transfer, click the Transfer button.



Currently, a few limitations apply in transferring audio to HD24 drives:

e Only existing audio can be overwritten. HD24connect will currently
not extend songs if the audio that you wish to write is longer than the
song length. This can be solved by recording silence after the end of
the song, using your HD24 recorder.

e Audio will always be written at the start of the song.

e Write protected songs can not be overwritten. You need to unprotect
them in the HD24 recorder.

e Each track will only be able to hold 1 audio file. This means no auto-
join will be performed on previously splitted audio files.

e No resampling will be performed. Sending a 16 kHz file to a 48 kHz
song will result in the audio being played back too fast.

HD24tools version 0.9 is the first version containing write support.
Because of this, it is a good idea to backup the song to be overwritten to
another drive that does not contain anything important, and then only
work with that backup. Use this functionality at your own risk, and please
report back any quirks that you may encounter.

For additional safety, you can save a backup of your HD24 drive to file
using the File -> Save Drive Image... menu option. This will cost
some time and require a lot of free drive space: as much as the capacity of
the drive being backed up.



Cross-application Audio

Introduction

The Linux version of HD24connect currently supports the Jack Audio
Connection Kit. This toolkit, which is functionally similar to Propellerhead
ReWire, allows routing audio streams between any applications that
support it. In other words, HD24connect is capable of streaming audio
directly from HD24 drives to any JACK enabled audio applications.

At this point in time, ReWire is not supported. There are a few reasons for
this:

e The ReWire specification is only available to commercial companies;

e Supporting ReWire would take away the choice of opening up
HD24tools to the public in the future.

Should you have any suggestions which could resolve these problems, I'd
be glad to hear about them.



Using JACK under Linux

HD24connect supports both OSS PortAudio and JACK under Linux, and
will use whatever is available at the time audio is activated. To enable
JACK output, make sure HD24connect is not playing back audio, then
start jackd in the usual way (most people use gjackctl). Clicking the
STOP transport control in HD24connect will allow HD24connect to detect
jackd and start the JACK client. After this, HD24tools will show up in the
connections list in gjacketl:
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From that point on, you need to connect the track outputs of HD24connect
to the audio inputs of the application that you want to route the audio to,
for instance Ardour. You can use gjackctl to do this. If you want to stop
using JACK, close down the JACK server. When HD24connect detects that
JACK is no longer available, it will fall back to PortAudio for audio
playback.



HD24 Drive recovery

Introduction

In HD24 ADAT recorder operation, a few situations can occur that may
cause data loss- which can not necessarily be blamed on the recorder
itself- power loss, user error, drive failure, and so on. In most cases, the
drive itself is not physically damaged — it merely is left in a state that
doesn't allow us to get to the audio anymore without the help of some
specialized tools.

HD24connect is champion of user-friendly drive recovery - for the first time
ever, a specialized tool is available that is so user-friendly that it enables
normal users to perform their own drive recoveries. In the following
chapters, we will discuss how. Drive recovery can be a very deeply
technical subject. Because of this, the author will attempt to explain things
simple enough to be understood by the average person.

A few words about drive layout

Like all file systems, the HD24 drive consists of a system area and a data
area. The data area contains data, which for the HD24 recorder means
audio; the system area (which we will also call the drive header) contains
information about how and where on disk that audio is stored. Important
parts of the system area are the superblock (which like most file systems
contains information about the drive parameters), the project list and the
song list.

Although audio data itself is not immune to trouble, little can go wrong
with its structure. Because of this, when the drive is left in an inconsistent
state, this will usually mean an inconsistency in the structure of the
system area (or drive header). If this is the case, by restoring the
consistency of the drive header, the drive will be readable again.



Types of recovery

There are different levels of performing a recovery. This manual will focus
on read-only recovery, which means we will limit ourselves to reading audio
data from disk. By performing a recovery as read-only process, we are safe
from doing any more damage.

If we wish to create a recovered disk which is readable by a HD24 recorder,
after transferring the audio to computer we can use the HD24 recorder
itself to write the recovered audio to a new disk (or even format the old one
and transfer the data there) by using the built-in FTP transfer capability of
the HD24 recorder.

For the most common types of recovery, the recovery procedure is similar.
Now that we have covered the basics, let us examine this general recovery
procedure.



General recovery procedure

Assuming you have properly installed HD24tools, there are only a few steps
that need to be performed to perform a read-only recovery:

e First of all, DO NOT use the drive for recording before recovery is
complete.

e Connect the corrupt ADAT HD24 drive to your system.

e Next, start up HD24connect.

e It is possible that the drive is not properly detected, in which case
HD24connect will show the an error message stating “No valid HD24
drive is connected to the system. Use the File menu to resolve this
problem.”



e If this is the case, you need to manually select the ADAT HD24 drive
with menu choice File -> Recovery -> Select device...
which will pop up a dialog allowing you to choose between drives on
your system. The device names in the dialog below may differ slightly
from your system.

Choose HDZ29 device

Current device:

Choose device: | /dev/sdc hd

Other device: |

oK | Cancell

e If you don't know which device is the ADAT HD24 drive, do not worry.
Connect another ADAT drive to the computer and re-detect the drive.
After this, the Select device... dialog will show the 'Current device'.
Write down which device it is; then connect the corrupt drive to the
HD24 and select that device for recovery.

e Normally you only need to manually select a device because
HD24connect didn't manage to auto-detect the drive. Because of this,
drive selection is usually followed by a pop-up dialog informing that
the device doesn't look like a valid ADAT drive:

- %]

Device does not appear to be a valid HD2 4 device.
r, Do you want to try using it anyway?
Warning: Choosing "Yes' may resultin
® crashes and other unpredictable behavior.

 Yes /i Mo

e If you are reasonably sure that in fact you have chosen the correct
drive, click Yes. HD24connect will attempt to use its own virtual
superblock to read the drive.



e HD24connect will now ask you the following question:

2 | Dovyou want to load a header file?

Only when you accidentally initialized a non-corrupt HD24 drive, it will be
enough to click No. In any other case, or when unsure, click Yes.

e Now it is time to select a header file. If the drive was automatically
detected properly, you will need to choose menu option

File -> Recovery —-> Load Headerfile...

e Now you can browse for a header file that matches your disaster
scenario, after which you will be able to transfer audio from disk to
your computer. For likely disaster scenarios, read the following
chapters.

There are currently two header files: longliverec and unquickformat.

The longliverec header tells HD24connect to treat the entire HD24 drive
as a single song. Previous versions were limited to sample rates of 44100
and 48000 Hz, and supported 16 and 24 tracks only. The last version
supports all sample rates and all track counts that the HD24 recorder
allows. Due to limitations in song length, only the first 27:03 or 24:51
hours of audio (at 44100 / 88200 Hz or 48000 / 96000 Hz, respectively) on
disk can be accessed.



Disaster scenarios

Now that we are up to speed about drive layout and types of recovery, we
can explore some disaster scenarios along with their solutions.

Power loss during a live recording

This is probably the most common disaster scenario to occur in the HD24
scene. A recorder is taken on location to a live recording session, where a
power loss occurs- either because the power fails, or a power chord is
pulled out, or because somebody accidentally hits the off switch.

What happens during a power loss?

While the HD24 recorder is recording, it is only writing audio data to the
data area of the disk. The length of a song or recording is not written to the
system area, because during recording there is no time to update that
information; also, the final size of the song is only known when you press
the STOP button of the recorder. As a result, when a power loss occurs, the
system area is not updated, leaving the disk in an inconsistent state, most
likely with the song length set to O and no information known about where
the audio is stored on disk.

How can you prepare to minimize the damage in case of a power loss?

There are a few things you can do to help reduce the chance of data loss
when power fails.

1. Ideally, get a UPS (Uninterruptible Power Supply). In case of a power
loss, this will provide the HD24 recorder with backup power and the
problem does not occur.

2. If possible, prepare your drive by recording silence to a song as long
as you expect the live recording to last. As information about where
the audio is recorded to is already known before recording, the disk
will not be corrupted in case of a power loss.

3. If the previous measures are too much trouble, at least quickformat
your drive before recording. This makes it easier to predict where the
audio will and up on disk.



4. Do not record anything on your drive between power loss and
recovery!

How can you recover audio from a drive that suffered a power loss?

Follow the general recovery procedure using the longliverec header file.
Choose the correct sample rate / number of tracks for your recording.
Fragments of audio recorded at a different sample rate or number of tracks
than selected will sound erratic; this is normal behaviour.

Accidentally initialized the drive on the computer

This is a mistake that you will probably make only once, and most likely it
will be the first time you connect an ADAT HD24 drive to your computer.
The computer will not be able to read this drive, and because of this
assume that it is an invalid or unformatted drive. Because of this, it is
possible that it will ask you a question along the lines of “The drive is not
initialized, do you wish to initialize it?” or “The drive is not formatted,
format it?”. When we answer Yes, the drive will no longer be readable by
the HD24 recorder.

What happens if the computer initializes the drive?

When the computer 'initializes' the drive, it will overwrite the first data
block of the drive (commonly called Master Boot Record or Superblock)
with a superblock that is recognized by the computer. However, this will
wipe out the signature by which the HD24 recorder and any HD24 related
software recognize the drive as ADAT HD24 drive. Fortunately, this
problem is relatively easy to resolve, for two reasons:

e The HD24 recorder keeps a backup of the original superblock
elsewhere on disk;

e HD24connect is able to use its own virtual superblock with HD24
disks.

How can you prevent yourself from accidentally initializing the drive?

There is not much more you can do except being aware that the computer
does not understand ADAT HD24 drives. Don't worry- you will quickly
learn not to make this mistake very often.



How can you recover audio from an accidentally initialized drive?

Use the general recovery procedure; after manually selecting the drive,
when asked 'Do you want to load a header file?' answer NO. This will cause
HD24connect to use its own virtual superblock.



Quickformatted the (wrong) drive on the HD24 recorder

To help you prevent mistakes, the HD24 recorder will require you to
confirm up to three times that you really wish to quickformat a drive. Yet,
accidentally quickformatting a drive is more common than you would
expect. One of the reasons is that it is not always entirely clear which drive
is being formatted.

What happens if the HD24 recorder quick-formats a drive?

Fortunately, when the HD24 recorder quick-formats a drive, all it does is
reset the project lists and drive usage information. The audio itself is still
there; and in fact, all song information still exists on disk as well. This
includes the allocation information which specifies where the audio resides
on disk.

How can you prevent yourself from accidentally quickformatting the (wrong) drive?

Making sure that the HD24 recorder only contains one drive when
quickformatting could help. Other than that, by asking for confirmation
three times the HD24 recorder already does pretty much everything
possible to prevent this situation.

How can you recover audio from an accidentally quickformatted drive?

Use the general recovery procedure with the unquickformat header file.
This will attempt to create a single virtual project with all songs in it. As
any project is limited to 99 songs, the total number of songs that can be
recovered is 99.



'Invalid Format'/'Corrupt Super Block' for no obvious reason

This is probably the hairiest disaster scenario of them all, because the
cause is not entirely clear. Possible causes include excessive vibration of
the unit during recording; a bad contact; or perhaps a bug in the software.
Typically, this problem occurs during longer recordings. During recording
everything seems fine, yet after the recording the HD24 recorder suddenly
claims 'Invalid Format' and the Fireport software claims 'Corrupt Super
Block', rendering the drive unreadable.

Also, when manually selecting the drive with HD24connect and NOT
loading a header file, the name last recorded project may appear damaged
(every other character in the name is messed up).

What happened?

It is still not entirely clear what causes this condition. For some reason,
during recording, from a certain point on something went wrong in writing
the data to disk. Every other byte of data written to disk was damaged from
that point on. As the song info, superblock and project info are updated,
these too are damaged. The last part of the audio of the last song that you
recorded may also be damaged. It is likely that some audio can not be
recovered because of this.

How can you prevent this situation?

As it is not entirely clear yet what causes this situation, not a lot can be
said about how to prevent it. However, here are some steps that may help:

e Typically this condition only occurs during longer recordings. This
suggests that keeping your recordings short will help prevent this
situation.

e If needed, prepare a disk with several songs so that during breaks
you can easily start recording to a new song. Once a song is recorded,
its audio will not be damaged.



e Bring several disks- should one disk give 'Invalid format' while
switching songs, you will have another one to continue the session.

How can you recover audio from this situation?

In this scenario, you will have the best chance of recovery by first
attempting the general recovery procedure without header file; then with
the unquickformat header file, and finally using the longliverec header
file. Most likely, part of the audio of the last recorded song is damaged. It is
very unlikely that any damaged audio can be restored.



'‘Audio block out of range' error

This error message will be displayed when a song uses up more audio
blocks on disk than its length would imply.

What happened?

There are two possible scenarios; one (theoretical) cause would be that a
power failure occurred right after pressing the 'stop' button on the HD24
recorder. This would however be extremely unlikely to occur. One other
possible cause may be that an audio block was incorrectly assigned to the
end of the song. This may have been done by our recovery service to allow
for enough silence to fit the song length. No data loss is caused by this
process.

How can you prevent this situation?

Power outages can be prevented with a UPS. The latter cause can usually
not be prevented.

How can you recover audio from this situation?

If the situation was caused by a power outage, proceed with the procedure
to recover from data loss due to power failures. If the situation was caused
by our recovery service, it should still be possible to backup the song from
one disk to another. After this, you can safely run the HD Scan utility on
the HD24 recorder to rectify the situation.



'Unexpected End of Song' error

This error message will be displayed when a song uses up less audio blocks
on disk than its length would imply. As the last part of the song is being
played, the HD24 recorder can no longer figure out where on disk the rest
of the audio is stored. Exporting the song with HD24connect will likely
result in loud noise from this same point on.

What happened?

Most likely your song is extremely fragmented. This may occur in rare
cases, most likely when recording a multitude of short takes as a single
song. The HD24 recorder reserves a fixed amount of space to hold
allocation information (which specifies where on disk the audio is stored).
As a result of the fragmented recording, the HD24 recorder has run out of
space to store allocation information.

Some evidence seems to point in the direction that only 20% of the
available allocation space is actually used by the HD24 recorder; this
would be a possible bug in the OS of the HD24 recorder. However, as of yet
there is no proof that this bug is for real. Also, under normal operating
conditions, even this 20% should be enough for most purposes.

How can you prevent this situation?

Leave the recorder running between takes; or use a new song for each take.

How can you recover audio from this situation?

Treat this in the same manner as a power loss during recording- use the
longliverec header file to find and export the lost audio fragments. As
allocation information is lost, you may want to send in your disk for
recovery.



Other disasters

Although most disaster scenarios are comparable with previously described
scenarios, there may be situations where following the general recovery
procedure is not enough. You may have projects that stretch beyond the
limitations of the longliverec header, or you may need to recover more
than the 99 songs offered by the unquickformat header, or you have a
specific scenario which is not covered or solveable by any of the previous
scenarios.

In such cases, you can try to create a header file and send it to us for
diagnostic purposes. This can be done by menu option

File -> Recovery -> Create header file...

This will allow the author to take a look at the disk structure, and possibly
create a custom header which will allow you to read your disk. A fee may
be charged for creating a custom header file. However, it may not always be
possible to perform a recovery based on a header file only. Specifically,
when it is necessary to reconstruct where and how the audio is stored on
disk, the audio itself (and thus the disk) will be needed to allow for a
recovery.

If the disk is required for recovery, or if this whole thing of header files and
read-only recoveries is too technical for you, you can send over your drive
for recovery. An advance is requested to cover sending costs and diagnosis.
Additionally, a (reasonable) fee is charged when recovery is successful. In
advance, please contact the author by email for pricing and contact info.



Using HD24hexview

Introduction

HD24hexview is a command-line on-disk hex viewer and editor which has
some features that help to make it suitable for working with HD24 drives.
However it can also be used to view and edit sectors of other drives.

If you are not familiar with hex editors and drive editors, you will probably
have little use for a program like HD24hexview, and you will be able to
safely ignore it. However if you have a technical background and you wish
to study the contents of your HD24 drive, HD24hexview is the tool of
choice.

Command line options

When starting HD24hexview, it is possible to pass it a few command line
options to alter its default behavior.

--dev=<device file>

Will allow you to use a device other than the first detected HD24
device.

Additionally, this will allow you to use image files as device.
--force

Allows you to use a device, even if it isn't recognized as valid HD24
device

--header=<header file>
Allows you to load a header file.
--expert

Starts hd24hexview in read-write mode instead of read-only mode.

Inside HD24hexview

While using hd24hexview, the most important command to remember is ?
because it will show you the help page of the program. You can exit the
program by typing q followed by enter. The displayed command list should
be pretty much self-explanatory. Feel free to contact the author if you feel
the options need more explanation.



Navigating the disk

There are three ways in which you can navigate the disk. The first is by
absolute sector numbers, done with the d command. For example, when at
the — prompt you type

dl4

this will display sector 14 (hexadecimal) of the disk. Keep in mind not to
use spaces. It is possible to navigate to the next and previous sector by
issuing the commands + and -, respectively. It is also possible to increment
by bigger steps; for instance,

+7

will cause HD24hexview to display the sector that is 7 sectors after the
current one. Finally, it is possible to navigate to sector numbers relative to
the end of the disk by using negative numbers. For example,

d-1
will display the last sector on disk. Under Windows, the first time you

navigate relative to the disk size, HD24hexview may need some time to
figure out how big the disk really is.



Known issues

Introduction

Although HD24tools is in a usable state, there are a few small issues and
limitations. Hopefully these will be overcome in a future release.

Drive size detection (Windows only)

The way Windows treats drives, there is no reliable way to detect the total
number of sectors on a drive. The only known solutions for this are either
obsolete (cylinder/head/sector method) or can only performed in a
hardware-specific manner (LBA count using DevicelOcontrol).

HD24hexview has a feature which allows it to read sectors relative to the
last sector on disk. On Windows only, HD24tools uses a special algorithm
to detect the actual drive size by itself, rather than relying on obsolete or
hardware-specific system calls. This method is now verified and known to
be sufficiently reliable.

In most cases, the drive size can be figured out in a very short amount of
time (up to a few seconds), but in some extreme cases the drive size
detection can take much longer (over five minutes). Currently, drive size
detection is performed only by HD24hexview, and only once per session.

Header file limitations

The header files currently provided for free download on the HD24tools
download page have some limitations. The longliverec header can only
handle around the first 24 hours of disk. The unquickformat header can
only bring back a maximum of 99 songs.

Crashes

The HD24tools suite is designed only to read ADAT FST disks. When
confronted with other drive formats than it recognizes, HD24tools may
crash.



	Introduction
	Thank you for reading this manual!

	About the HD24tools software
	Key features of the HD24tools software
	What's new in this last version?

	Before using the software
	Choosing your hardware
	System recommendations
	Precautions
	Installing HD24tools (Windows)
	Installing HD24tools (Linux)
	Installing HD24tools (Mac)

	Normal operation
	The main screen of HD24connect
	Drive info
	Project/Song tab
	The Recorder
	Copying audio from HD24 drives
	Copying audio to HD24 drives

	Cross-application Audio
	Introduction 
	Using JACK under Linux

	HD24 Drive recovery
	Introduction 
	A few words about drive layout
	Types of recovery
	General recovery procedure

	Disaster scenarios
	Power loss during a live recording
	What happens during a power loss?

	Accidentally initialized the drive on the computer
	What happens if the computer initializes the drive?
	How can you recover audio from an accidentally initialized drive?

	Quickformatted the (wrong) drive on the HD24 recorder
	What happens if the HD24 recorder quick-formats a drive?
	How can you prevent yourself from accidentally quickformatting the (wrong) drive?
	How can you recover audio from an accidentally quickformatted drive?

	'Invalid Format'/'Corrupt Super Block' for no obvious reason
	What happened? 
	How can you prevent this situation?
	How can you recover audio from this situation?

	'Audio block out of range' error
	What happened? 
	How can you prevent this situation?
	How can you recover audio from this situation?

	'Unexpected End of Song' error
	What happened? 
	How can you prevent this situation?
	How can you recover audio from this situation?

	Other disasters

	Using HD24hexview
	Introduction
	Command line options
	Inside HD24hexview
	Navigating the disk

	Known issues
	Introduction
	Drive size detection (Windows only)
	Header file limitations
	Crashes


